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BAB III  

METODE PENELITIAN 

3.1 Objek Penelitian 

Objek penelitian ini adalah pengukuran kualitas pelayaan kesehatan yang 

berada di UPT Layanan Kesehatan Klinik Pratama Universitas Pendidikan 

Indonesia. Meliputi pelayanan medis dasar, pemeriksaan umum, pemeriksaan gigi, 

dan konsultasi gizi yang di sediakan 

Secara lebih spesifik, penelitian ini akan menganalisis dimensi-dimensi 

kualitas pelayanan seperti dimensi penampilan fisik (Tangibility), kehandalan 

(Reliability), Cepat Tanggap (Responsiveness), jaminan keamanan (Assurance), 

dan sikap peduli (Emphaty). Selain itu penelitian ini juga akan mengeksplorasi 

bagaimana upaya perbaikan berkelanjutan yang telah dilakukan oleh UPT Layanan 

Kesehatan UPI berdampak pada peningkatan kualitas pelayanan yang dirasakan 

oleh pasien. 

Hasil penelitian ini diharapkan dapat memberikan rekomendasi praktis dan 

terukur bagi UPT Layanan Kesehatan UPI untuk terus meningkatkan kualitas 

pelayanan mereka, sehingga dapat memenuhi kebutuhan dan harapan pasien 

dengan lebih baik, serta meningkatkan daya saing di era persaingan layanan 

kesehatan yang semakin ketat. 

3.2 Metode dan Desain Penelitian 

3.2.1 Metode Penelitian 

Penelitian ini menggunakan pendekatan kuantitatif deskriptif dengan desain 

survei. Pendekatan kuantitatif dipilih karena memungkinkan untuk mengukur dan 

menganalisis data secara objektif dan sistematis, sehingga dapat memberikan 

gambaran yang jelas mengenai kualitas pelayanan di UPT Layanan Kesehatan UPI 

Klinik Pratama. Data kuantitatif akan dikumpulkan melalui kuesioner yang 

dirancang untuk mengukur persepsi pasien terhadap berbagai aspek pelayanan, 

termasuk tingkat kepentingan dan kinerja atribut-atribut pelayanan yang dinilai 

penting. 
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3.2.2 Desain Penelitian 

Desain survei digunakan untuk mengumpulkan data dari sampel pasien 

melalui kuesioner. Kuesioner dirancang untuk mengukur persepsi pasien terhadap 

berbagai aspek pelayanan, termasuk gap antara tingkat kepentingan (Importance) 

dan tingkat kinerja (Performance) dari atribut-atribut pelayanan yang relevan. 

Desain survei memungkinkan peneliti untuk menjangkau sejumlah besar responden 

dalam waktu yang relatif singkat dan mengumpulkan data yang diperlukan untuk 

analisis Importance-Performance Analysis (IPA) dan Custumer Index Satisfaction 

(CSI). 

Importance-Performance Analysis (IPA) adalah teknik analisis yang 

digunakan untuk memprioritaskan area perbaikan berdasarkan persepsi pelanggan 

mengenai tingkat kepentingan dan kinerja suatu produk atau layanan. Sedangkan 

Custumer Index Satisfaction (CSI) digunakan untuk mengetahui tingkat kepuasan 

pasien UPT Layanan Kesehatan UPI secara menyeluruh dengan memperhatikan 

tingkat kepentingan dan kinerja dari atribut-atribut. 

3.3 Operasional Variabel 

Tabel 3. 1 

Operasional Variabel 

Variabel Dimensi Indikator Skala 

Pengukuran 

No Item 

Pertanyaan 

Service 

Quality 

Penilaian 

pelanggan 

terhadap 

tingkat 

pelayanan 

yang 

diterima 

dibandingkan 

dengan 

tingkat 

Tangibles 

(Bukti Fisik) 

Jarak dan 

kemudahan 

transportasi 

menuju lokasi 

UPT Layanan 

Kesehatan UPI. 

Ordinal 

(Skala likert 

1-5) 

T1 

Tingkat 

kebersihan dan 

kenyamanan 

fasilitas UPT 

Layanan 

Kesehatan UPI. 

Ordinal 

(Skala likert 

1-5) 

T2 
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Variabel Dimensi Indikator Skala 

Pengukuran 

No Item 

Pertanyaan 

pelayanan 

yang 

diharapkan. 

Kelengkapan 

dan kondisi 

peralatan medis. 

Ordinal 

(Skala likert 

1-5) 

T3 

Ketersediaan 

dengan jelasan 

papan informasi 

di area UPT 

Layanan 

Kesehatan UPI. 

Ordinal 

(Skala likert 

1-5) 

T4 

Reliability 

(Keandalan) 

Kemampuan 

memberikan 

pelayanan yang 

sesuai dengan 

jadwal yang 

tertera. 

Ordinal 

(Skala likert 

1-5) 

RY 5 

Tingkat 

kesesuaian 

informasi yang 

disampaikan 

staff UPT 

Layanan 

Kesehatan UPI. 

Ordinal 

(Skala likert 

1-5) 

RY 6 

Waktu yang 

dibutuhkan 

selama 

melakukan 

pendaftaran dan 

administrasi. 

Ordinal 

(Skala likert 

1-5) 

RY 7 

Tingkat 

kepuasan pasien 

pada pelayanan 

yang diberikan 

setiap 

kunjungan. 

Ordinal 

(Skala likert 

1-5) 

RY 8 

Responsiveness 

(Daya 

Tanggap) 

Kecepatan dan 

ketanggapan 

staff membantu 

Ordinal 

(Skala likert 

1-5) 

RS 9 
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Variabel Dimensi Indikator Skala 

Pengukuran 

No Item 

Pertanyaan 

dan 

memberikan 

pelayanan 

kepada pasien. 

Durasi/waktu 

rata-rata pasien 

menunggu 

sebelum 

pemeriksaan. 

Ordinal 

(Skala likert 

1-5) 

RS 10 

Kecepatan dan 

efektivitas 

penanganan 

keluhan pasien. 

Ordinal 

(Skala likert 

1-5) 

RS 11 

Jumlah staf 

yang siap siaga 

dalam keadaan 

darurat. 

Ordinal 

(Skala likert 

1-5) 

RS 12 

Assurance 

(Jaminan) 

Tingkat rasa 

aman dan 

kepercayaan 

pasien terhadap 

kompetensi 

tenaga 

kesehatan. 

Ordinal 

(Skala likert 

1-5) 

A 13 

Sikap ramah 

dan sopan staff 

saat berinteraksi 

dengan pasien. 

Ordinal 

(Skala likert 

1-5) 

A 14 

Tingkat rasa 

aman pasien 

pada sistem 

perlindungan 

data yang 

diterapkan UPT 

Layanan 

Kesehatan UPI. 

Ordinal 

(Skala likert 

1-5) 

A 15 
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Variabel Dimensi Indikator Skala 

Pengukuran 

No Item 

Pertanyaan 

Tingkat 

kepercayaan 

pasien terhadap 

keamanan 

selama 

melakukan 

pelayanan. 

Ordinal 

(Skala likert 

1-5) 

A 16 

Empathy 

(Empati) 

Kemampuan 

staff dalam 

bersikap dalam 

menangani 

keluhan pasien. 

Ordinal 

(Skala likert 

1-5) 

E 17 

Kemampuan 

staff dalam 

menyesuaikan 

layanan sesuai 

kebutuhan 

individu pasien. 

Ordinal 

(Skala likert 

1-5) 

E 18 

Kemampuan 

staff memahami 

situasi dan 

kondisi 

psikologis 

pasien. 

Ordinal 

(Skala likert 

1-5) 

E 19 

Pemaparan 

penjelasan dan 

kesederhanaan 

bahasa yang 

digunakan staff 

kepada pasien. 

Ordinal 

(Skala likert 

1-5) 

E 20 

 

3.4 Instrumen Penelitian 

Instrumen penelitian yang digunakan dalam penelitian ini adalah kuesioner. 

Kuesioner dipilih karena efisien dalam menjangkau sejumlah responden dan 

memungkinkan pengumpulan data terstruktur yang dapat dianalisis secara 

kuantitatif. Terdapat 20 pertanyaan yang bertujuan untuk mengukur ekspektasi dan 
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presepsi responden terhadap kualitas pelayanan, maupun tingkat kepentingan 

berbagai atribut pelayanan. Kuesioner ini akan mengukur variabel-variabel seperti 

kualitas pelayanan (dengan dimensi kehandalan, daya tanggap, jaminan, empati, 

dan bukti fisik), kepuasan pasien, mutu pelayanan kesehatan, dan perbaikan 

berkelanjutan. 

Kuesioner terdiri dari beberapa bagian, meliputi informasi demografis 

responden, pertanyaan mengenai persepsi terhadap kualitas pelayanan, serta 

pertanyaan mengenai tingkat kepentingan dan kinerja atribut pelayanan. 

Pertanyaan-pertanyaan dalam kuesioner menggunakan skala Likert untuk 

mengukur sikap, pendapat, dan persepsi responden terhadap variabel-variabel 

penelitian. Skala Likert memungkinkan responden untuk mengekspresikan tingkat 

persetujuan atau ketidaksetujuan terhadap pernyataan yang diberikan, sehingga 

memberikan data ordinal yang dapat dianalisis secara statistik. 

3.5 Sumber dan Alat Pengumpulan Data 

Pengumpulan data dilakukan untuk mendukung penelitian ini agar bisa 

mendapatkan hasil yang akurat. Pada bagian ini menjelaskan tentang sumber data, 

jenis data yang digunakan dalam penelitiaan serta alat untuk mengumpulkan data 

data tersebut. 

3.5.1 Jenis dan Sumber Data 

Data yang akan digunakan pada penelitian ini berasal dari dua sumber yaitu 

data primer dan data sekunder. Data primer dan sekunder pada penelitian ini 

merupakan. 

1. Data Primer 

Data primer adalah data yang diperoleh langsung oleh peniliti dari objek 

penelitiannya, yaitu pasien yang telah menerima pelayanan di UPT Layanan 

Kesehatan UPI. Data primer dalam penelitian ini diperoleh melalui 

wawancara dengan pihak UPT Layanan Kesehatan UPI dan survei kepada 

pasien yang menerima layanan kesehatan di UPT Layanan Kesehatan UPI 

(Saviea dan Subadi, 2023). 

2. Data Sekunder 
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Data sekunder adalah data yang diperoleh dari sumber-sumber yang sudah 

ada, secara tidak langsung dari objek penelitian (Savira dan Subadi, 2023). 

Data yang digunakan seperti literatur atau jurnal ilmiah seperti teori dan 

penelitian terdahulu yang berfungsi sebagai landasan teori, perbandingan 

penelitian, maupun kerangka penelitian dalam penelitian ini. 

Dengan menggabungkan data primer dan data sekunder, penelitian ini 

diharapkan dapat memberikan gambaran yang komprehensif dan mendalam 

mengenai kualitas pelayanan di UPT Layanan Kesehatan UPI. 

3.5.2 Alat Pengumpulan Data 

Penelitian ini menggunakan beberapa teknik pengumpulan data untuk 

mendapatkan informasi yang akurat dan relevan mengenai kualitas layanan pada 

UPT Layanan Kesehatan UPI. Teknik yang digunakan meliputi kuisioner dan 

wawancara, yang masing-masing memiliki fungsi dalam pengumpulan data. 

1. Kuisioner 

Kuisioner digunakan sebagai alat pengumpulan data utama dalam penelitian 

ini. Kuesioner ini dirancang untuk mengumpulkan data yang relevan dengan 

tujuan penelitian, dengan menggunakan SERVQUAL sebagai landasan utama 

yang mencakup lima dimensi SERVQUAL yaitu Tangibles (Bukti Fisik), 

Reliability (Keandalan), Responsiveness (Daya tanggap), Assurance 

(Jaminan), dan Empathy (Empati).  Kuesioner terdiri dari beberapa bagian, 

termasuk pertanyaan demografis, pertanyaan mengenai persepsi responden 

terhadap kualitas pelayanan yang diukur menggunakan skala likert, dan 

pertanyaan tambahan mengenai situasi langsung kualitas layanan yang 

diterima oleh responden untuk mendukung keakuratan penilaian. Kuesioner 

ini disebarkan kepada responden yang memenuhi kriteria yang telah 

ditetapkan kemudian dianalisis untuk mengidentifikasi kesenjangan/gap 

antara harapan dan kenyataan. 

Proses distribusi kuisioner dilakukan secara daring maupun langsung melalui 

Google Forms. Tautan kuesioner dibagikan kepada calon responden melalui 

treads X dan followers Instagram UPT Layanan Kesehatan UPI. Adapu 
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didistribusikan secara langsung kepada responden di lingkungan Kampus 

UPI. 

2. Wawancara 

Pada penelitian ini peneliti menggunakan wawancara dengan manajemen 

UPT Layanan Kesehatan UPI untuk mendapatkan pemahaman mendalam 

terkait data-data yang atau informasi yang membantu peneliti mendapatkan 

informasi mendalam dan kontekstual yang tidak dapat diperoleh melalui 

kuisoner. 

Dengan menggabungkan kuesioner dan wawancara, penelitian ini diharapkan 

dapat memperoleh data yang lengkap dan akurat sebagai landasan penelitian dan 

mencapai tujuan penelitian. 

3.6 Populasi, Sampel dan Teknik Penarikan Sampel 

3.6.1 Populasi 

Populasi merupakan keseluruhan entitas, baik berupa individu, kelompok, 

objek, maupun fenomena, yang menjadi sasaran pengamatan atau analisis oleh 

peneliti. Dalam pendekatan kuantitatif, populasi dipahami sebagai wilayah 

generalisasi yang terdiri dari elemen-elemen yang memiliki karakteristik tertentu 

dan relevan dengan tujuan penelitian. Sementara itu, dalam pendekatan kualitatif, 

populasi lebih dipahami sebagai situasi sosial yang melibatkan tempat, pelaku, dan 

aktivitas, yang dipilih karena dianggap mampu merepresentasikan konteks 

fenomena yang diteliti secara mendalam. Oleh karena itu, definisi populasi tidak 

bersifat tunggal, tetapi disesuaikan dengan pendekatan metodologis yang 

digunakan. 

Dalam penelitian ini berdasarka, populasi terdiri dari individu-individu yang 

memiliki karakteristik yang sama, yaitu mahasiswa S-1 yang mendapatkan layanan 

yang bersifat free of chage yang pernah menjadi pasien di UPT Layanan Kesehatan 

UPI. Populasi ini bukan hanya sekadar jumlah pasien, tetapi juga meliputi seluruh 

karakteristik atau sifat yang dimiliki oleh subjek tersebut, seperti usia, jenis 

kelamin, asal fakultas, asal angkatan dan lain-lain. Berdasarkan data yang diambil 
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dari SIET UPI, jumlah mahasiswa S-1 yang berada di UPI kampus Setiabudi 

sebanyak 39.237 mahasiswa. 

 

Gambar 3. 1 Populasi Mahasiswa S1 

Sumber: Website SIET UPI (2025) 

3.6.2 Sampel 

Sampel adalah sebagai bagian dari populasi yang dipilih untuk mewakili 

karakteristik keseluruhan populasi dengan cara tertentu agar data yang diperoleh 

relevan dan valid untuk dianalisis. Pemilihan sampel bersifat subjektif dan purposif, 

lebih menekankan pada kedalaman informasi daripada kuantitas. Sampel dalam 

penelitian kuantitatif sering disebut responden(Amin et al., 2023). 

Dalam penelitian ini, sampel akan diambil dari populasi mahasiswa 

Universitas Pendidikan Indonesia kampus Bumi Siliwangi yang merupakan pasien 

UPT Layanan Kesehatan UPI untuk mengumpulkan data mengenai persepsi mereka 

terhadap kualitas pelayanan, tingkat kepentingan berbagai atribut pelayanan, dan 

tingkat kinerja aktual pelayanan yang diberikan. 

Ukuran sampel akan ditentukan menggunakan rumus Slovin, dengan 

mempertimbangkan tingkat kepercayaan dan margin of error yang ditetapkan. 

Rumus Slovin adalah sebagai berikut: 

n = 
𝑁

( 1 + 𝑁 (𝑒)2 
 

Dimana: 
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• n = Ukuran sampel 

• N =Ukuran populasi 

• e = Margin of error (tingkat kesalahan yang dapat ditolerir) 

Berdasarkan populasi mahasiswa S-1 UPI di kampus Setiabudi sebanyak 

32.018 mahasiswa. 

n= 
32.018

1+32.018 x (0.052)
 

n= 
32.018

1+32.018 x (0,0025)
 

n= 
32.018

1+80,045
 

n=395 

Maka dari itu, sampel yang digunakan sebanyak 395 

Terdapat 9 fakultas S-1 yang terdapat di UPI Kampus Bumi Siliwangi dengan 

rata-rata pengunjung UPT Layanan Kesehatan UPI dalam satu tahun mencapai 

10.000. Persebaran kuesioner 

3.6.3 Teknik Sampling 

Teknik sampling yang digunakan dalam penelitian ini adalah proporsional 

random sampling. Teknik proporsional random sampling menggabungkan 

pengambilan sampel secara proporsional dari setiap fakultas dalam populasi dengan 

pemilihan sampel berdasrkan kriteria tertentu yang relevan dengan tujuan 

penelitian peneliti (Amin et al., 2023). 

 yang ingin mendapatkan informasi dari responden yang memiliki 

pengalaman langsung menggunakan layanan UPT Layanan Kesehatan 

UPI. Dengan kriteria inklusi dalam penelitian ini adalah: 

1. Mahasiswa S-1 Universitas Pendidikan Indonesia 

2. Pernah menggunakan layanan UPT Layanan Kesehatan UPI minimal 1 kali 

dalam satu tahun terakhir. 

Dengan menggunakan proporsional random sampling maka persebaran kuisioner 

sebagai berikut: 

Tabel 3. 2Persebaran Sampel 

Fakultas Populasi Sampel 
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FIP 5.247 65 

FPIPS 5.241 65 

FPBS 3.883 48 

FPMIPA 3.891 48 

FPTI 4.197 52 

FPOK 3.554 44 

FPEB 3.392 42 

FPSD 2.521 31 

FK 92 1 

TOTAL  395 

Sumber: Data Penelitian (2025) 
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3.7 Rancangan Analisis Data 

 
Gambar 3. 2 

Flowchart Analisis Data 
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3.8 Teknik Analisis Data 

Teknik analisis data dalam penelitian ini dilakukan dengan beberapa tahapan, 

yaitu pengujian validitas dan reliabilitas instrumen penelitian, analisis Service 

Quality (SERVQUAL), analisis Customer Satisdaction Index (CSI) serta untuk 

menentukan prioritas perbaikan layanan.menggunakan Importance Performance 

Analysis (IPA) 

3.8.1 Uji Validitas 

Uji validitas digunakan untuk mengukur sejauh mana suatu alat ukur benar-

benar mengukur apa yang seharusnya diukur. Dengan kata lain, validitas menilai 

ketepatan dan kecermatan suatu instrumen dalam melaksanakan fungsi ukurnya 

(Fakhri Ramadhan et al., 2024). 

 Salah satu metode yang digunakan adalah validitas konstruk, yang dapat 

diuji menggunakan validitas korelasi item-total. Dalam metode ini, setiap butir 

pertanyaan pada kuesioner akan dikorelasikan dengan skor total variabelnya 

menggunakan korelasi Pearson Product Moment. Rumus yang digunakan adalah: 

𝑟= 
𝑛(∑ 𝑋𝑌)−(∑ 𝑋)( ∑ 𝑌)

√[𝑛 ∑ 𝑋2)−(∑ 𝑋 )2][𝑛 ∑ 𝑌2)−(∑ 𝑌 )2]
 

Dimana: 

• r  = Koefisien korelasi 

• 𝑥𝑖  = Nilai x ke-i 

• 𝑦𝑖  = Nilai y ke-i 

• 𝑛  = Banyaknya Nilai 

Kriteria uji: 

• Apabila setiap butir dari pertanyaan hasilnya adalah r hitung lebih besar 

dari r tabel (r hitung ≥ r tabel), maka item dinyatakan valid. 

• Akan tetapi, jika setiap butir dari pertanyaan hasilnya adalah r hitung lebih 

kecil dari r tabel (r hitung ≥ r tabel), maka item dinyatakan tidak valid dan 

harus direvisi atau dihapus. 

A. Uji Validitas Harapan 

Adapun hasil pengujian untuk lima dimensi SERVQUAL pada bagian harapan 

atau expectation.  
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Tabel 3. 3 Uji Validitas Harapan Dimensi Tangible 

TANGIBLE 

Indikator Pertanyaan r-Hitung r-Tabel Keterangan 

T1 Kemudahan akses lokasi UPT 

Layanan Kesehatan UPI 

0.671 0.312 Valid 

T2 Kebersihan dan kenyamanan 

fasilitas (Seperti ruang tunggu, 

ruang pemeriksaan, toilet, dll.) 

0.802 0.312 Valid 

T3 Ketersediaan perlatan medis 

yang lengkap dan terawat. 

0.750 0.312 Valid 

T4 Papan informasi dan petunjuk 

yang jelas di area layanan. 

0839 0.312 Valid 

Sumber: Diolah oleh peneliti dengan SPSS (2025) 

Berdasarkan tabel 3.3 dapat dilihat bahwa uji validitas harapan untuk dimensi 

tangible dengan menggunakan bantuan software spss menunjukkan semua nilai r 

hitung lebih besar dari nilai r tabel sebesar 0.312. Semua pernyataan dinyatakan 

valid karena nilai r hitung > r table. Maka dari itu berdasarkan pengujian tersebut 

didapatkan bahwa semua indikator telah memenuhi krieria. 

Tabel 3. 4 Validitas Harapan Dimensi Realibilitas 

REALIBILITAS 

Indikator Pertanyaan r-Hitung r-Tabel Keterangan 

RY5 Ketepatan waktu pelayanan 

sesuai jadwal operasional UPT 

Layanan Kesehatan UPI. 

0.856 0.312 Valid 

RY6 Keakuratan informasi yang 

diberikan staff. 

0.866 0.312 Valid 

RY7 Kecepatan proses pendaftaran 

dan pelayanan administratif. 

0.827 0.312 Valid 

RY8 Konsistensi kualitas layanan 

setiap kunjungan. 

0.801 0.312 Valid 

Sumber: Diolah oleh peneliti dengan SPSS (2025) 
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Berdasarkan tabel 3.4 dapat dilihat bahwa uji validitas harapan untuk dimensi 

reliability dengan menggunakan bantuan software spss menunjukkan semua nilai r 

hitung lebih besar dari nilai r tabel sebesar 0.312. Semua pernyataan dinyatakan 

valid karena nilai r hitung > r table. Maka dari itu berdasarkan pengujian tersebut 

didapatkan bahwa semua indikator telah memenuhi krieria. 

Tabel 3. 5 Uji Validitas Harapan Dimensi Responsiveness 

RESPONSIVENESS 

Indikator Pertanyaan r-Hitung r-Tabel Keterangan 

RS9 Ketanggapan respon staff saat 

membutuhkan bantuan. 

0.898 0.312 Valid 

RS10 Waktu tunggu untuk 

mendapatkan layanan relatif 

singkat 

0.604 0.312 Valid 

RS11 Penanganan keluhan dan solusi 

dengan sigap. 

0.901 0.312 Valid 

RS12 Ketersediaan staf saat kondisi 

darurat. 

0.858 0.312 Valid 

Sumber: Diolah oleh peneliti dengan SPSS (2025) 

Berdasarkan tabel 3.4 dapat dilihat bahwa uji validitas harapan untuk dimensi 

reliability dengan menggunakan bantuan software spss menunjukkan semua nilai r 

hitung lebih besar dari nilai r tabel sebesar 0.312. Semua pernyataan dinyatakan 

valid karena nilai r hitung > r table. Maka dari itu berdasarkan pengujian tersebut 

didapatkan bahwa semua indikator telah memenuhi krieria. 

Tabel 3. 6 Uji Validitas Harapan Dimensi Assurance 

ASSURANCE 

Indikator Pertanyaan r-Hitung r-Tabel Keterangan 

A13 Kompetensi dan keahlian 

tenaga medis. 

0.830 0.312 Valid 
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A14 Keramahan staf dalam 

berkomunikasi. 

0,813 0.312 Valid 

A15 Keamanan data pribadi 

pasien. 

0.765 0.312 Valid 

A16 Memberikan rasa aman 

selama proses layanan. 

0.899 0.312 Valid 

Sumber: Diolah oleh peneliti dengan SPSS (2025) 

Berdasarkan tabel 3.4 dapat dilihat bahwa uji validitas harapan untuk dimensi 

reliability dengan menggunakan bantuan software spss menunjukkan semua nilai r 

hitung lebih besar dari nilai r tabel sebesar 0.312. Semua pernyataan dinyatakan 

valid karena nilai r hitung > r table. Maka dari itu berdasarkan pengujian tersebut 

didapatkan bahwa semua indikator telah memenuhi krieria. 

Tabel 3. 7 Uji Validitas Harapan Dimensi Emphty 

EMPHATY 

Indikator Pertanyaan r-Hitung r-Tabel Keterangan 

E17 Bersikap sopan, sabar dan 

peduli terhadap keluhan pasien. 

0.842 0.312 Valid 

E18 Perhatian personal terhadap 

kebutuhan spesifik pasien. 

0.738 0.312 Valid 

E19 Pemahaman staff terhadap 

kondisi psikologis pasien. 

0.899 0.312 Valid 

E20 Penjelasan staff yang mudah 

dipahami oleh pasien 

0.919 0.312 Valid 

Sumber: Diolah oleh peneliti dengan SPSS (2025) 

Berdasarkan tabel 3.4 dapat dilihat bahwa uji validitas harapan untuk dimensi 

reliability dengan menggunakan bantuan software spss menunjukkan semua nilai r 

hitung lebih besar dari nilai r tabel sebesar 0.312. Sehingga dapat disimpulkan 

bahwa semua atribut atau semua pernyataan dinyatakan valid karena nilai r hitung 

> r table. 

B. Uji Validitas Kenyataan 
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Adapun hasil pengujian untuk lima dimensi SERVQUAL pada bagian harapan 

atau expectation.  

Tabel 3. 8 Uji Validitas Kenyataan Dimensi Tangible 

TANGIBLE 

Indikator Pertanyaan r-Hitung r-Tabel Keterangan 

T1 Kemudahan akses lokasi UPT 

Layanan Kesehatan UPI 

0.696 0.696 Valid 

T2 Kebersihan dan kenyamanan 

fasilitas (Seperti ruang tunggu, 

ruang pemeriksaan, toilet, dll.) 

0.644 0.644 Valid 

T3 Ketersediaan perlatan medis 

yang lengkap dan terawat. 

0.653 0.653 Valid 

T4 Papan informasi dan petunjuk 

yang jelas di area layanan. 

0.754 0.754 Valid 

Sumber: Diolah oleh peneliti dengan SPSS (2025) 

Berdasarkan tabel 3.3 dapat dilihat bahwa uji validitas kenyataan untuk dimensi 

tangible dengan menggunakan bantuan software spss menunjukkan semua nilai r 

hitung lebih besar dari nilai r tabel sebesar 0.312. Semua pernyataan dinyatakan 

valid karena nilai r hitung > r table. Maka dari itu berdasarkan pengujian tersebut 

didapatkan bahwa semua indikator telah memenuhi krieria. 

Tabel 3. 9 Uji Validitas Kenyataan Dimensi Reliabilitas 

REALIBILITAS 

Indikator Pertanyaan r-Hitung r-Tabel Keterangan 

RY5 Ketepatan waktu pelayanan 

sesuai jadwal operasional UPT 

Layanan Kesehatan UPI. 

0.78 0.312 Valid 

RY6 Keakuratan informasi yang 

diberikan staff. 

0.729 0.312 Valid 

RY7 Kecepatan proses pendaftaran 

dan pelayanan administratif. 

0.889 0.312 Valid 
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RY8 Konsistensi kualitas layanan 

setiap kunjungan. 

0.849 0.312 Valid 

Sumber: Diolah oleh peneliti dengan SPSS (2025) 

Berdasarkan tabel 3.3 dapat dilihat bahwa uji validitas kenyataan untuk dimensi 

tangible dengan menggunakan bantuan software spss menunjukkan semua nilai r 

hitung lebih besar dari nilai r tabel sebesar 0.312. Semua pernyataan dinyatakan 

valid karena nilai r hitung > r table. Maka dari itu berdasarkan pengujian tersebut 

didapatkan bahwa semua indikator telah memenuhi krieria. 

Tabel 3. 10 Uji Validitas Kenyataan Dimensi Responsivenes 

RESPONSIVENES 

Indikator Pertanyaan r-Hitung r-Tabel Keterangan 

RS9 Ketanggapan respon staff saat 

membutuhkan bantuan. 

0.78 0.312 Valid 

RS10 Waktu tunggu untuk 

mendapatkan layanan relatif 

singkat 

0.729 0.312 Valid 

RS11 Penanganan keluhan dan solusi 

dengan sigap. 

0.889 0.312 Valid 

RS12 Ketersediaan staf saat kondisi 

darurat. 

0.849 0.312 Valid 

Sumber: Diolah oleh peneliti dengan SPSS (2025) 

Berdasarkan tabel 3.3 dapat dilihat bahwa uji validitas kenyataan untuk dimensi 

tangible dengan menggunakan bantuan software spss menunjukkan semua nilai r 

hitung lebih besar dari nilai r tabel sebesar 0.312. Semua pernyataan dinyatakan 

valid karena nilai r hitung > r table. Maka dari itu berdasarkan pengujian tersebut 

didapatkan bahwa semua indikator telah memenuhi krieria. 

Tabel 3. 11 Uji Validitas Kenyataan Dimensi Assurance 

ASSURANCE 

Indikator Pertanyaan r-Hitung r-Tabel Keterangan 
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A13 Kompetensi dan keahlian 

tenaga medis. 

0.78 0.312 Valid 

A14 Keramahan staf dalam 

berkomunikasi. 

0.729 0.312 Valid 

A15 Keamanan data pribadi 

pasien. 

0.889 0.312 Valid 

A16 Memberikan rasa aman 

selama proses layanan. 

0.849 0.312 Valid 

Sumber: Diolah oleh peneliti dengan SPSS (2025) 

Berdasarkan tabel 3.3 dapat dilihat bahwa uji validitas kenyataan untuk dimensi 

tangible dengan menggunakan bantuan software spss menunjukkan semua nilai r 

hitung lebih besar dari nilai r tabel sebesar 0.312. Semua pernyataan dinyatakan 

valid karena nilai r hitung > r table. Maka dari itu berdasarkan pengujian tersebut 

didapatkan bahwa semua indikator telah memenuhi krieria. 

Tabel 3. 12 Uji Validitas Kenyataan Dimensi Emphty 

EMPHATY 

Indikator Pertanyaan r-Hitung r-Tabel Keterangan 

E17 Bersikap sopan, sabar dan 

peduli terhadap keluhan pasien. 

0.78 0.312 Valid 

E18 Perhatian personal terhadap 

kebutuhan spesifik pasien. 

0.729 0.312 Valid 

E19 Pemahaman staff terhadap 

kondisi psikologis pasien. 

0.889 0.312 Valid 

E20 Penjelasan staff yang mudah 

dipahami oleh pasien 

0.849 0.312 Valid 

Sumber: Diolah oleh peneliti dengan SPSS (2025) 

Berdasarkan tabel 3.3 dapat dilihat bahwa uji validitas kenyataan untuk dimensi 

tangible dengan menggunakan bantuan software SPSS menunjukkan semua nilai r 

hitung lebih besar dari nilai r tabel sebesar 0.312. Semua pernyataan dinyatakan 
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valid karena nilai r hitung > r table. Maka dari itu berdasarkan pengujian tersebut 

didapatkan bahwa semua indikator telah memenuhi krieria. 

3.8.2 Uji Reliabilitas 

Reliabilitas mengindikasikan sejauh mana instrumen memberikan hasil yang 

konsisten tanpa dipengaruhi oleh faktor kebetulan atau kesalahan pengukuran. 

Instrumen yang reliabel akan menghasilkan data yang seragam jika pengukuran 

diulang, baik dalam waktu maupun oleh penilai yang berbeda (Fakhri Ramadhan et 

al., 2024). 

Uji reliabilitas dalam penelitian ini bertujuan untuk mengukur konsistensi dan 

keandalan instrumen kuesioner dalam mengumpulkan data terkait kualitas layanan, 

efisiensi layanan, dan perbaikan berkelanjutan. Instrumen yang reliabel akan 

memberikan hasil yang stabil dan konsisten meskipun digunakan pada waktu atau 

responden yang berbeda. Salah satu metode yang umum digunakan adalah uji 

reliabilitas dengan Cronbach’s Alpha, yang mengukur sejauh mana item-item dalam 

satu variabel memiliki keterkaitan internal. Rumus Cronbach’s Alpha adalah: 

α=
𝑁

𝑁−1
(1 −

∑ 𝜎𝑖
2

𝜎t
2 ) 

Dimana: 

• α\alphaα = Koefisien reliabilitas (Cronbach’s Alpha) 

• NNN = Jumlah butir pertanyaan dalam satu variabel 

• σi2\sigma^2_iσi2 = Varian dari setiap butir pertanyaan 

• σt2\sigma^2_tσt2 = Varian total dari seluruh butir pertanyaan dalam 

variable 

Dengan kriteria: 

Tabel 3. 13 

Tabel Tingkat Reliabilitas 

Alpha Cronbach’s Tingkat Reliabilitas 

0,00 – 0,20 Kurang Reliabel 

0,21 – 0,40 Agak Reliabel 

0,41 – 0,60 Cukup Reliabel 
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0,61 – 0,80 Reliabel 

0,81 – 1,00 Sangat Reliabel 

Sumber: (Ramadhan et al,2024). 

Nilai Cronbach’s Alpha ≥ 0.70 dianggap menunjukkan reliabilitas yang baik, 

sedangkan nilai di bawah 0.60 menunjukkan bahwa instrumen kurang reliabel dan 

memerlukan revisi. Dalam penelitian ini, uji reliabilitas akan diterapkan pada 

seluruh variabel utama, yaitu realibility, responsiveness, assurance, emphaty, dan 

tangibles. 

Tabel 3. 14 Tabel Uji Reliabilitas Harapan 

Cronbach's 

Alpha 
N of Items 

0.974 20 

Sumber: Diolah oleh peneliti dengan SPSS (2025) 

Uji reliabilitas dilakukan pada instrumen harapan atau persepsi pengguna 

dengan tujuan untuk mengetahui tingkat konsistensi internal dari instrumen dengan 

menggunakan nilai Cronbach’s Alpha melalui bantuan SPSS. Berdasarkan tabel 

3.13 dapat dilihat bahwa uji reliabilitas harapan yaitu sebesar 0.974 dengan N of 

item sebanyak 20. Nilai tersebut berada diantara range 0.81-1.00 sehingga masuk 

ke dalam kategori sangat reliabel. 

Tabel 3. 15 Tabel uji realibilitas Kenyataan 

Cronbach's 

Alpha 
N of Items 

0.964 20 

Sumber: Diolah oleh peneliti dengan SPSS (2025) 

Uji reliabilitas dilakukan pada instrumen harapan atau persepsi pengguna 

dengan tujuan untuk mengetahui tingkat konsistensi internal dari instrumen dengan 

menggunakan nilai nilai Cronbach’s Alpha melalui bantuan SPSS. Berdasarkan 

tabel 3.14 dapat dilihat bahwa uji reliabilitas kenyataan dengan menggunakan 
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bantuan software spss nilai cronbach’s alpha yaitu sebesar 0.964 dengan N of item 

sebanyak 20. Nilai tersebut berada diantara range 0.81-1.00 sehingga masuk ke 

dalam kategori sangat reliabel. 

3.8.3 Analisis Service Quality (SERVQUAL) 

Pengumpulan data dalam penelitian ini menggunakan survey yaitu dengan 

membuat daftar pertanyaan atau kuisioner yang disebar kepada 395 responden yaitu 

pasien UPT Layanan Kesehatan UPI. Data kuisioner terdiri dari 5 dimensi Service 

Quality (SERVQUAL) dengan masing-masing dimensi memiliki 4 atribut. Atribut-

atribut tersebut didapat dari penelitian terdahulu yang sesuai dengan keadaan UPT 

Layanan Kesehan UPI.  

Analisis Service Quality (SERVQUAL) digunakan untuk mengukur 

kesenjangan atau gap antara ekspektasi dan persepsi pasien terhadap layanan yang 

diberikan UPT Layanan Kesehatan UPI. Model SERVQUAL terdiri dari lima 

dimensi utama, yaitu Tangibles (Bukti Fisik), Reliability (Keandalan), 

Responsiveness (Daya tanggap), Assurance (Jaminan), dan Empathy (Empati). 

Rumus gap SERVQUAL: 

GAP = Perceived Service Quality – Expecterf Service Quality 

Keterangan: 

• Perceived Service Quality = Persepsi pelanggan terhadap layanan yang 

diterima 

• Expected Service Quality = Ekspektasi pelanggan terhadap layanan ideal 

• GAP > 0 menunjukkan bahwa layanan melebihi harapan pelanggan 

• GAP = 0 menunjukkan layanan sesuai dengan harapan pelanggan 

• GAP < 0 menunjukkan adanya kekurangan dalam kualitas layanan 

A. Dimensi SERVQUAL 

Tabel 3. 16Dimensi SERVQUAL 

Kode Item  

TANGIBLE 

T1 Kemudahan akses lokasi UPT Layanan Kesehatan UPI 
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T2 Kebersihan dan kenyamanan fasilitas (Seperti ruang tunggu, 

ruang pemeriksaan, toilet, dll.) 

T3 Ketersediaan perlatan medis yang lengkap dan terawat. 

T4 Papan informasi dan petunjuk yang jelas di area layanan. 

RELIABILITY 

RY5 Ketepatan waktu pelayanan sesuai jadwal operasional UPT 

Layanan Kesehatan UPI. 

RY6 Keakuratan informasi yang diberikan staff. 

RY7 Kecepatan proses pendaftaran dan pelayanan administratif. 

RY8 Konsistensi kualitas layanan setiap kunjungan. 

RESPONSIVENESS 

RS9 Ketanggapan respon staff saat membutuhkan bantuan. 

RS10 Waktu tunggu untuk mendapatkan layanan relatif singkat 

RS11 Penanganan keluhan dan solusi dengan sigap. 

RS12 Ketersediaan staf saat kondisi darurat. 

ASSURANCE 

A13 Kompetensi dan keahlian tenaga medis. 

A14 Keramahan staf dalam berkomunikasi. 

A15 Keamanan data pribadi pasien. 

A16 Memberikan rasa aman selama proses layanan. 

EMPATHY 

E17 Bersikap sopan, sabar dan peduli terhadap keluhan pasien. 

E18 Perhatian personal terhadap kebutuhan spesifik pasien. 

E19 Pemahaman staff terhadap kondisi psikologis pasien. 

E20 Penjelasan staff yang mudah dipahami oleh pasien 

 

B. Proses Pengolahan SERVQUAL 

Pada penelitian ini pengolahan data dilakukan menggunakan tools Microsoft Excel 

untuk menganalisis gap, IPA, dan CSI secara terstruktur. Tahap pengolahan data 

dilakukan sebagai berikut: 

1. Proses Input Data Kuesioner 

Kuisioner dioleh menggunakan Google Form yang dimana data terhubung 

pada Google Spreadsheet. Data dibagikan dalam bentuk tautan untuk ke 

Microsoft Excel. Langkah yang dilakukan File > Bagikan > Publikasikan 

ken Web. 
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Langkah selanjutnya dalam Microsoft Excel memilih tab Data laluk 

menarik data menggunakan fitur Get Data > From Other Sources > From 

Web > tempelkan URL dari Google Spreadsheet. Dengan begitu data 

kuisioner pada Google Spreadsheet sudah terhubung secara otomatis pada 

Microsoft Excel. Apabila terdapat perubahan atau penambahan data di 

Google Spreadsheet, cukup menekan tombol Refresh di Excel untuk 

memperbarui data secara otomatis tanpa harus melakukan impor ulang. 

 

Gambar 3. 2 Excel Tahap I 

Sheet "Hasil Kuesioner" merupakan bagian awal dari proses pengumpulan 

data dalam penelitian ini. Di dalamnya terdapat data mentah yang diperoleh 

langsung dari responden melalui penyebaran kuesioner. Kuesioner disusun 

berdasarkan indikator-indikator yang mengacu pada lima dimensi 

SERVQUAL, yaitu tangible, reliability, responsiveness, assurance, dan 

empathy. Setiap indikator diukur dalam dua aspek yaitu expectation dan 

preception pengguna. 

Selain data jawaban kuesioner, sheet ini juga memuat informasi dasar seperti 

nama responden, usia, asal angkatan, serta asal fakultas. Tujuannya adalah 

untuk memberikan konteks terhadap data yang diperoleh dan memastikan 

bahwa responden benar-benar memiliki pengalaman menggunakan layanan 

UPT Layanan Kesehatan UPI. 

Data dari sheet ini menjadi dasar penting untuk proses analisis selanjutnya. 

Tahap ini hanya berfungsi sebagai tempat pengumpulan informasi awal. Oleh 

karena itu, sheet ini digunakan untuk mengolah, menghitung, dan 

diinterpretasikan melalui metode SERVQUAL yang akan dijabarkan pada 

sheet berikutnya. 
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2. Analisis gap  

Tahap selanjutnya yaitu rekapitulasi data gap dan penentuan peringkat 

berdasarkan atribut layanan. 

Perhitungan gap diulang untuk setiap atribut pertanyaan dengan cara men-

drag rumus ke seluruh baris yang relevan. 

Seluruh proses ini dilakukan secara otomatis dan terstruktur pada Excel, 

sehingga menghasilkan data gap yang akan dianalisis untuk IPA dan CSI 

 

Gambar 3. 3 Excel Tahap II 

Pada sheet "SERVQUAL" merupakan tahap awal pengolahan data dari hasil 

kuesioner. Di sheet ini dilakukan perhitungan terhadap nilai dari setiap 

indikator layanan berdasarkan dua komponen utama, yaitu kenyataan 

(persepsi) dan harapan (ekspektasi). Dengan membandingkan kedua nilai 

tersebut, diperoleh hasil selisih atau disebut sebagai gap SERVQUAL. Gap 

ini merepresentasikan tingkat kepuasan pelanggan terhadap kualitas layanan 

yang diterima. 

Jika nilai gap bernilai negatif, hal ini menunjukkan bahwa harapan pelanggan 

belum terpenuhi oleh kenyataan layanan yang mereka terima. Sebaliknya, 

jika nilai gap positif atau nol menunjukkan bahwa layanan sudah sesuai atau 

melebihi harapan. Dengan demikian, perhitungan gap ini menjadi tolok ukur 

penting untuk menilai performa layanan perusahaan dari sudut pandang 

pelanggan. 

Pada sheet SERVQUAL masukan data responden menggunakan rumus: 

=INDEX('Hasil Kuisioner'!$C$2:$C$2283, INT((ROW()-5)/3)+1) 



69 

Azzahra Nur Tsaniyah, 2025 
ANALISIS KUALITAS PELAYANAN UNTUK PERBAIKAN BERKELANJUTAN DI UPT LAYANAN 
KESEHATAN UPI 
Universitas Pendidikan Indonesia | repository.upi.edu | perpustakaan.upi.edu 

 

Untuk menampilkan kolom masing-masing atribut digunakan rumus : 

=SUBSTITUTE('Hasil Kuisioner'!H1, "[Expectation]"," ") 

Selanjutnya untuk mempermudah proses analisis gap selanjutnya dengan 

memisahkan nilai ekspektasi dan presepsi. Rumus data ekspektasi : 

=INDEX('Hasil Kuisioner'!H$2:H$2283, INT((ROW()-5)/3)+1) 

Rumus data presepsi : 

=INDEX('Hasil Kuisioner'!I$2:I$2283, INT((ROW()-5)/3)+1) 

Setelah didapatkan data ekspektasi dan presepsi selanjutnya menghitung nilai 

gap atau selisih dari keduanya, dengan rumus : 

=D7-D6 

3. Hasil SERVQUAL  

 

Gambar 3. 4 Excel Tahap IV 

Sheet "Hasil SERVQUAL" merupakan tempat penyajian hasil akhir dari 

analisis SERVQUAL secara keseluruhan. Di sini, semua indikator dari 
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masing-masing dimensi layanan ditampilkan lengkap dengan nilai rata-rata 

serta nilai gap-nya. Selain menampilkan skor gap, sheet ini juga menyertakan 

peringkat (ranking) dari tiap dimensi berdasarkan besar kecilnya nilai gap. 

Dengan demikian, peneliti dan pihak manajemen dapat dengan cepat 

mengetahui urutan prioritas berdasarkan persepsi dan harapan pelanggan 

yang telah dianalisis. Peringkat ini sangat berguna untuk memfokuskan 

sumber daya perusahaan pada perbaikan layanan yang benar-benar signifikan 

dari sudut pandang pelanggan. 

3.8.4 Importance Performance Analysisis (IPA) 

Analisis IPA akan digunakan untuk mengidentifikasi atribut-atribut 

pelayanan yang dianggap penting oleh pasien namun belum memuaskan, sehingga 

dapat menjadi fokus utama untuk perbaikan. 

Data dikumpulkan melalui kuesioner yang berisi 20 pertanyaan mengenai 

ekspektasi dan presepsi pengunjung terhadap tingkat kepuasan pelayanan yang 

diberikan UPT Layanan Kesehatan UPI. Menggunakan skala pengukuran yang 

digunakan adalah skala Likert 1-5. 

Tabel 3. 17 

Skala Likert Instrumen Penelitian 

Pertanyaan Nilai Skor 

Sangat Baik 5 

Baik 4 

Cukup Baik 3 

Tidak Baik 2 

Sangat Tidak Baik 1 

Sumber: (Sugiyono, 2016) 

Langkah-langkah Analisis IPA: 

4. Mengukur Tingkat Kesesuaian 

Hal ini untuk mengetahui apakah atribut kinerja sudah memenuhi harapan 

Rumus: 
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TKi=(
Yi

Xi
)×100% 

Dimana: 

• Tki = Tingkat Kesesuaian 

• Xi = Skor penilaian ekspektasi 

• Yi  = Skor penilaian presepsi 

5. Perhitungan Rata-rata 

Nilai rata-rata Importance (I) dan Performance (P) digitung untuk setiap 

atribut pelayanan 

Rumus Rata-rata: 

Rata-rata (X) = 
(𝛴𝑋𝑖)

𝑛
  Rata-rata (Y) = 

(𝛴𝑌𝑖)

𝑛
 

Dimana: 

• XI = Skor rata-rata ekspektasi 

• YI = Skor rata-rata presepsi 

• n  = Jumlah responden 

Rata-rata seluruh atribut tingkat kepentingan (Y) dan kinerja (X) yang 

menjadi batas dalam diagram kartesius 

6. Pemetaan Diagram Kartesius 

Tahap terakhir yaitu pemetaan diagram kartesius dibuat dengan sumbu X 

mewakili tingkat kinerja (Performance) dan sumbu Y mewakili tingkat 

kepentingan (Importance). 

Penentuan Titik Tengah: 

Titik tengah (center point) diagram kartesius ditentukan dengan menghitung 

rata-rata keseluruhan nilai Importance dan Performance. 

Rumus titik Tengah: 

Titik Tengan Importance (Ī) = (
𝛴Ri

𝑘
) 

Titik Tengah Performance (P̄)= (
𝛴Rp

𝑘
) 

Dimana: 

• Ri adalah rata-rata Importance untuk setiap atribut 

• Rp adalah rata-rata Performance untuk setiap atribut 
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• k adalah jumlah atribut pelayanan 

Diagram kartesius dibagi menjadi empat kuadran, yaitu: 

• Kuadran I (Concentrate Here): Atribut yang dianggap sangat penting oleh 

pasien, tetapi kinerjanya masih rendah. Atribut pada kuadran ini menjadi 

prioritas utama untuk perbaikan. 

• Kuadran II (Keep Up the Good Work): Atribut yang dianggap sangat 

penting oleh pasien dan kinerjanya sudah baik. Organisasi harus 

mempertahankan kinerja pada atribut ini. 

• Kuadran III (Low Priority): Atribut yang dianggap kurang penting oleh 

pasien dan kinerjanya juga rendah. Atribut pada kuadran ini tidak menjadi 

prioritas utama. 

• Kuadran IV (Possible Overkill): Atribut yang dianggap kurang penting 

oleh pasien, tetapi kinerjanya sangat baik. Organisasi dapat 

mempertimbangkan untuk mengurangi sumber daya yang dialokasikan 

untuk atribut ini dan mengalihkannya ke atribut lain yang lebih penting. 

Proses Analisis Importance Performance Analysis 

Setelah gap ditemukan selanjutnya adalah menghitung rata-rata harapan dan 

persepsi dengan rumus: 

=SUMPRODUCT((MOD(ROW(SERVQUAL!$D$6:$D$1190)-

6,3)=0)*(ISNUMBER(INDEX(SERVQUAL!$D$6:$AU$1190,,(ROW(A1)-

1)*2+1)))*(INDEX(SERVQUAL!$D$6:$AU$1190,,(ROW(A1)-

1)*2+1)))/SUMPRODUCT((MOD(ROW(SERVQUAL!$D$6:$D$1190)-

6,3)=0)*(ISNUMBER(INDEX(SERVQUAL!$D$6:$AU$1190,,(ROW(A1)-

1)*2+1)))) 

Nilai rata-rata ini akan digunakan sebagai nilai tengah (cut-off point) dalam 

pemetaan kuadran IPA (sumbu X dan Y). 

Teknis pembuatan Matriks IPA 

a) Pilih Data: 

Sumbu X = Nilai rata-rata harapan 

Sumbu Y = Nilai rata-rata kenyataan/persepsi 
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b) Insert Grafik Scatter: 

Insert → Chart → Scatter (X,Y) with Markers Only 

c) Tambahkan Label Atribut: 

Klik titik data → Klik kanan → Add Data Labels → Format Data Labels 

→ Value from Cells → Pilih kolom atribut 

d) Tambahkan Garis Cut-Off (Garis Tengah): 

Garis vertikal di rata-rata harapan (X-axis) 

Garis horizontal di rata-rata persepsi (Y-axis) 

Gunakan dummy data + scatter plot baru atau gunakan fitur Shapes 

e) Klasifikasi ke Kuadran: 

Kuadran I (Prioritas Utama): Importance tinggi, Performance rendah 

Kuadran II (Pertahankan Prestasi): Importance tinggi, Performance 

tinggi 

Kuadran III (Prioritas Rendah): Importance rendah, Performance rendah 

Kuadran IV (Berlebihan): Importance rendah, Performance tinggi 

3.8.5 Analisis Customer Sasisfaction Index (CSI) 

Custumer Index Satisfaction (CSI) atau indeks kepuasan konsumen 

merupakan metode melihat tingkat kinerja dari produk atau jasa yang telah diukur. 

CSI dapat memberikan evaluasi secara berkala untuk memberikan perbaikan 

kualitas layanan. Menghitung nilai besaran CSI dapat dilakukan dengan Langkah-

langkah sebagi berikut: 

1. Menghitung Mean Importance Score (MIS) dan Mean Satisfaction Score MIS 

dan MSS adalah skor rata-rata dari kepentingan suatu atribut, dan untuk MSS 

merupakan skor rata-rata tingkat kepuasan yang berasal dari kinerja jasa yang 

dapat dirasakan oleh pengunjung. 

MIS = [
∑ 𝑌𝑖𝑛

𝑖=1

𝑛
] 

Keterangan : 

Yi = Nilai Kepentingan atribut Y ke i 

n = Jumlah responden 

MSS = [
∑ 𝑋𝑖𝑛

𝑖=1

𝑛
] 
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Keterangan: 

Xi = Nilai Kepuasan atribut X ke i 

n = Jumlah Responden. 

2. Menentukan Weight Factor (WF), ini adalah bobot persentase dari nilai MIS 

per indikator terhadap nilai MIS untuk seluruh indikator. Dapat dihitung 

dengan persamaan. 

MF = [
𝑀𝐼𝑆𝑖

∑ 𝑀𝐼𝑆𝑖
𝑝
𝑖=1

𝑥 100%] 

Keterangan: 

MISi = Nilai rata-rata kepentingan ke i 

∑ 𝑀𝐼𝑆𝑖𝑝
𝑖=1  = Total rata-rata kepentingan dari i ke p. 

3. Menentukan Weight Score (WS), merupakan bobot dari perkalian WF dan 

nilai rata-rata tingkat kepuasan. Dapat digitung dengan persamaan. 

WS𝑖 = 𝑊𝐹𝑖 × 𝑀𝑆𝑆 

Keterangan: 

WFi = Faktor tertimbang ke z 

4. CSI dapat dihitung dengan menggunakan persamaan. 

CSI = [
∑ 𝑊𝑆𝑖

𝑝
𝑖=1

𝐻𝑆
𝑥100%] 

Keterangan : 

∑ 𝑊𝑆𝑖𝑝
𝑖=1  = Total rata-rata kepentingan dari i ke p. 

HS = skala maksimum yang dugunakan atau highest scale 

Setelah menghitung CSI selanjutnya menentukan angka indeks berada pada kriteria 

apa, berdasarkan table berikut, 

Tabel 3. 18 Kritesia Tingkat Kepuasan 

Index Score Interpretasi 

X ≤ 64% Verry Poor 

64% < X ≤ 71% Poor 

71% < X ≤ 77% Cause for Concern 

77% < X ≤ 80% Borderline 

80% < X ≤ 84% Good 
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84% < X ≤ 87% Verry Good 

87% < X Excelent 

Sumber:(Sihotang & Oktarina, 2022) 

Langkah selanjutnya yaitu menghitung CSI untuk mengetahui indeks keseluruhan 

kepuasan pasien terhadap layanan. Perlu menghitung rata-rata nilai persepsi dan 

harapan dari tiap atribut, dengan rumus: 

=AVERAGE(B3:B396) 

Selanjutnya menghitung Weighted Score 

=E401*D401 

Sedangkan untuk menghitung WF 

=(C401/$C$421)*100 

Langkah terakhir yaitu menghitung CSI yaitu 

= Total Weighted Score × 100 

 


